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Copyrights & Warranty 
© Copyright 2008 by the manufacturer. All Rights Reserved. 

No part of this publication may be reproduced or distributed in any form or by any means, 
electronic or mechanical, for any purpose, without the express written permission of the 
manufacturer. 

Microsoft is a registered trademark of Microsoft Corp. 
All other products or services referred to in this manual are the trademarks, service marks, or 
product names of their respective holders. 

DISCLAIMER: The information, products and specifications, configurations, and other 
technical information regarding the products contained in this manual are subject to change 
without notice. All the statements, technical information, and recommendations contained 
in this manual are believed to be accurate and reliable but are presented without warranty of 
any kind, and users must take full responsibility for the application of any products 
specified in this manual. 
IN NO EVENT SHALL THE MANUFACTURER OR ITS SUPPLIERS BE LIABLE FOR 
ANY INDIRECT, SPECIAL, CONSEQUENTIAL, OR INCIDENTAL DAMAGES, 
INCLUDING, WITHOUT LIMITATION, LOST PROFITS OR LOSS OR DAMAGE TO 
DATA ARISING OUT OF THE USE OR INABILITY TO USE THIS MANUAL, EVEN IF 
THE MANUFACTURER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH 
DAMAGES. 

WARRANTY 
The manufacturer and/or its subsidiaries and its affiliates ("the Manufacturer") warrants its 
products hereinafter referred to as "the Product" or "Products" to be in conformance with its 
own plans and specifications and to be free of defects in materials and workmanship under 
normal use and service for a period of 24 months from the date of shipment by the 
Manufacturer.  The Manufacturer's obligations shall be limited within the warranty period, at its 
option, to repair or replace the product or any part thereof.  
This warranty does not apply in the following cases: improper installation, misuse, failure to 
follow installation and operating instructions, alteration, abuse, accident or tampering. 
This warranty is exclusive and expressly in lieu of all other warranties, obligations or liabilities, 
whether written, oral, express or implied, including any warranty of merchantability or fitness 
for a particular purpose, or otherwise.  In no case shall the Manufacturer be liable to anyone for 
any consequential or incidental damages for breach of this warranty or any other warranties 
whatsoever, as aforesaid. 
This warranty shall not be modified, varied or extended, and the Manufacturer does not 
authorize any person to act on its behalf in the modification, variation or extension of this 
warranty. This warranty shall apply to the Product only.  All products, accessories or 
attachments of others used in conjunction with the Product, including batteries, shall be 
covered solely by their own warranty, if any.  
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The Manufacturer shall not be liable for any damage or loss whatsoever, whether directly, 
indirectly, incidentally, consequentially or otherwise, caused by the malfunction of the Product 
due to products, accessories, or attachments of others, including batteries, used in conjunction 
with the Products. 
The Manufacturer does not represent that its Product may not be compromised and/or 
circumvented, or that the Product will prevent any death, personal and/or bodily injury and/or 
damage to property resulting from unauthorized entry, burglary, robbery, or otherwise, or that 
the Product will in all cases provide adequate warning or protection. User understands that a 
properly installed and maintained access control system may only reduce the risk of 
unauthorized entry without warning, but it is not insurance or a guarantee that such will not 
occur or that there will be no death, personal damage and/or damage to property as a result. 
The Manufacturer shall have no liability for any death, personal and/or bodily injury 
and/or damage to property or other loss whether direct, indirect, incidental, consequential 
or otherwise, based on a claim that the Product failed to function.  However, if the 
Manufacturer is held liable, whether directly or indirectly, for any loss or damage arising under 
this limited warranty or otherwise, regardless of cause or origin, the Manufacturer's maximum 
liability shall not in any case exceed the purchase price of the Product, which shall be fixed as 
liquidated damages and not as a penalty, and shall be the complete and exclusive remedy 
against the Manufacturer. 
 
Document revision 08/2008 
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About This Manual 
This manual provides a detailed description of the procedures for using the Amber Basic 
PC Remote Programmer with your Amber Basic system.  
Chapter 1 provides an overview and briefly describes the system. 
Chapter 2 lists the requirements for installing the software and describes the software 
installation process. 
Chapter 3 covers the menus included in the software. 
Chapter 4 introduces Sites and how they are managed (creating, saving, deleting and 
copying). 
Chapter 5 explains how to manage Amber Basic PC Remote Programmer users, 
including how to add users, delete users, change a user’s password and how to log in as a 
different user. 
Chapter 6 details all the different tables displayed in the software and provides a general 
overview of what is included in them. 
Chapter 7 describes how to edit text in the control panel LCD display.  
Chapter 8 describes how to download/upload customized data settings. 
Chapter 9 covers the Reports utility, detailing how to define and generate reports. 
Chapter 10 describes how to change the screen appearance, change the screen color, 
column alignment and user interface language. 
Chapter 11 provides answers to troubleshooting questions, which may occur. 
Appendix A provides solutions in the event of characters not appearing correctly due to 
the interface language used and for custom language editing. 
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Formatting Conventions 
The following formatting conventions are used throughout the documentation: 
Note: Additional information relevant to the presently 

discussed subject. 

Caution: Information that is essential for your safety and to avoid 
damaging the hardware or software. 

bold text Indicates operations that you must perform (e.g., name 
of a button to be clicked or option to be selected) or to 
emphasize a field or concept being described. 
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Chapter 1: Introduction 
The Amber Basic PC Remote Programmer is a utility program that enables you to manage 
the Amber Basic control panel from a remote station. It runs on PC workstations with 
Microsoft® Windows 2000 or Windows XP.  

It allows offline preparation of specifications, each of which is a set of parameters 
especially tailored for a particular Amber Basic PC Remote Programmer installation site. 
After the user has prepared the parameters for the site, they can be downloaded into the 
Amber Basic control panel on the site. 

Data is transferred to and from the Amber Basic PC Remote Programmer either locally 
through an RS-232 serial data cable, as shown in figure 1-1, or remotely via telephone lines 
and a modem, as shown in figure 1-2. For local connection, connect the optional plug-in 
RS-232 module (PN 0-5924-0) to the connector of the Amber Basic control panel, and then 
connect the RS-232 cable to a local PC. 

Local Data Transfer enables the operator to prepare the parameters for the Amber Basic 
control panel on a PC where the operator specifies parameters in the Site Screens, even 
though the operator is working at the same installation site. The operator then transfers the 
data to the control panel through a cable. 

LOCAL SETUP
no modem is
required for

local download

Amber Basic PC
Remote Programmer Amber Basic

RS-232
CABLE

 
Figure 1-1: Setup for Local Data Transfer 

Remote Data Transfer enables the operator to work from a remote site where several 
Amber Basic systems can be controlled at different installation sites. Using the Amber 
Basic PC Remote Programmer, the operator can compare the parameters of the different 
systems and copy them if necessary. The data is then transferred to each Amber Basic PC 
Remote Programmer through a modem. 

 RS-232 CABLE

REMOTE SETUP-
EXTERNAL MODEM

EXTERNAL
MODEM

TEL. LINE

Amber Basic

Amber Basic PC
Remote Programmer

 
Figure  1-2: Setup for Remote Data Transfer with an External Modem 

Note: An external modem is required. It is recommended to use the approved model, 
USR 5686 or USR 5633 from US Robotics. 
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Chapter 2: Getting Started  
2.1 Hardware / Software Requirements 

In order to run Amber Basic PC Remote Programmer, you need the following resources: 
• PC workstation with Pentium microprocessor (100 MHz or higher) 

• Microsoft Windows 2000 or Windows XP.  

• 128 megabytes of RAM (minimum) 

• Hard disk with at least 8 megabytes of free space. 

• For best performance, use a display driver with a resolution of at least 1024 x 768 pixels. 

2.2 Installation 
Use an RS-232 cable to connect an external modem to one of the computer’s COM ports as 
instructed in the manual supplied with the modem. Then connect the modem to the 
telephone line. 

To Install the Modem 

1. Install the modem for use with the remote computer. 

2. Restart your computer. In most cases Windows will detect the new hardware and 
will open a dialog box prompting you to install the driver for the new modem 
(from the manufacturer’s CD). 

If Windows does not recognize the modem during startup, do the following:  

3. From the Start menu, select Settings, then Control Panel; the control panel 
window appears.  

4. Double-click the Modems icon; the Modem Properties dialog box appears.  
Note: In Windows XP the Modems icon is located under Printers and other 
Hardware.  

5. Click Add; the Install New Modem wizard begins. Follow the instructions to 
enable Windows detect and install the new modem. 

To Install Amber Basic PC Remote Programmer 

1. Start Windows. Close all running applications, if any. 

2. Insert the Amber Basic PC Remote Programmer CD into the CD-ROM drive. 

 If your system includes the AutoPlay feature, the setup program starts 
automatically. Otherwise, proceed as follows: 



2-2______________________________________________________________ Getting Started  

3. From the Start menu, select Run; the Run dialog box appears.  

4. In the Run edit box, type the drive letter of the CD drive you are using, followed 
by a colon, backslash, and the word “setup”, for example: "d:\setup". 

5. Click OK. The installation welcome screen appears and the Installation program 
guides you through the entire process. 

6. Click Next, then follow the instructions on your screen to complete the 
installation.  

During installation an Amber Basic PC Remote Programmer shortcut icon 
is placed on the Desktop to enable you to start Amber Basic PC Remote 
Programmer easily. 

 

To Start Amber Basic PC Remote Programmer 

1. On the Windows Desktop, double-click on the Amber Basic PC Remote 
Programmer icon; the Login screen appears. 

 
Figure  2-1: Login Screen 

2. In the Operator edit box, enter your user name (visonic, by default). 

3. In the Password edit box, enter your password (amber, by default). 

  Both entries are case-sensitive. 

 The main Amber Basic PC Remote Programmer screen appears with the Sites 
List in the foreground as the active window.  
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Figure  2-2: Site List Window 

This window enables you: to open an existing site file; create a new site file; copy a site 
file; delete a site file or exit the program. Refer to “Chapter 4. Sites” for further details. 

2.3 Amber Basic PC Remote Programmer Main Window 
The Amber Basic PC Remote Programmer main window displays all the main features of 
Amber Basic PC Remote Programmer. This enables you to manage the Amber Basic 
control panel easily and efficiently.  

 
Figure  2-3: Amber Basic PC Remote Programmer Main Screen 

Title Bar 
The title bar displays the following features: 
• The name of the Amber Basic PC Remote Programmer file that you have opened. 

Menu bar 

Tool bar 

List of 
Tables 

Status bar 

Table Data 
Details 

Screen 
Tabs 

Title bar 
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• The windows Minimize button.  

• The windows Maximize button.  

• The windows Close button. 

Menu Bar 
Displays the menus that enable you to access Amber Basic PC Remote Programmer 
features. 

List of Tables 
This area displays a list of all the data tables containing information which characterizes the 
site. As you point to each table title, it appears underlined. Click on a title to display that 
table data. 

Table Data 
This area contains detailed data included in the selected table.  

Type in settings, or double-click on the down-pointing arrow to display a drop-down list, 
and select the appropriate value. 

Toolbar 
Amber Basic PC Remote Programmer provides a toolbar that displays buttons which 
are shortcuts to the most frequently used features of the system. 

Button Name Function Also 
accessible 
through menu 

 

New Displays the New Sites window. Sites 

 

Sites Displays the Sites List window (including Site 
information). 

Sites 

 

Save Saves the site file displayed on the screen. Sites 
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Button Name Function Also 
accessible 
through menu 

 

Search Displays the Sites window (without Site 
information). 

View Sites 

 

Options Displays the Options dialog box. View 

 

Back  Displays the previous table according to the List 
of Tables. 

View 

 

Next Displays the next table according to the List of 
Tables. 

View 

 

Login  Connects the Amber Basic PC Remote 
Programmer to the control panel. 

Communications 

 

Download Downloads data from the Amber Basic PC 
Remote Programmer to the control panel. 

Communications 

 

Upload Uploads data from the control panel to the Amber 
Basic PC Remote Programmer and automatically 
updates files. 

Communications 
 

 

Download 
Table 

Downloads data from the table currently visible 
on the screen to the control panel. 

Communications 
 

 

Upload 
Table  

Uploads data from the control panel to the table 
currently visible on the screen. 

Communications 
 

 

Help Displays the Amber Basic PC Remote 
Programmer Help files. 

Help 
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Status Bar 
The Status Bar appears at the bottom of the Amber Basic PC Remote Programmer screen. It 
displays the following: 
• Menu name 

• Caps lock 

• Number lock 

• Communication Status: The communication status is displayed by the color of the two 
communication status icons: 

Program Status Left Icon Right Icon 

Communication is offline Gray Gray 

Communication is online Dark green Dark green 

Downloading to control panel Dark green Light green 

Uploading from control panel Light green Dark green 
• Amber Basic model: Displays the Amber Basic model name. 

2.4 Navigating Amber Basic PC Remote Programmer 
You can move around the Amber Basic PC Remote Programmer screen and carry out 
functions in a variety of ways: 

Mouse 
Use the mouse to point to a position on the screen, then click the left mouse button. This 
enables you to do the following: 
• Click a button. 

• Select a table tab in the main screen. 

• Place the cursor within a table edit box. 

• Display a drop-down list. 

Arrow and Tab keys 
The arrow and tab keys enable you to move around the Amber Basic PC Remote 
Programmer tables and highlight the edit boxes. However, they do not position the cursor at 
the insertion point; this is performed using the mouse or by pressing Enter. 
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2.5 Exiting Amber Basic PC Remote Programmer 
At any time, you can exit Amber Basic PC Remote Programmer.  

To Exit the Program 

1. From the Sites menu, select Exit. A popup message appears prompting 
you to save the recent changes to the system.  

2. Click Yes to save or No to disregard recent changes. Amber Basic PC 
Remote Programmer closes.
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Chapter 3: Menus 
The Amber Basic PC Remote Programmer main screen displays six menus, which enable 
you to access the different features of the application. 

3.1 Sites Menu 
The Sites menu provides you with the tools to manage new and existing Sites. 

Menu Item Function 
List of Sites… Displays the Sites window (with Site information). 
New Site  Displays the New Site window. 
Search  Displays the Sites window (without Site information).  
Save  Saves an existing Site file.  
Save As…  Enables you to save a site file by a new name. 
Close Site Enables you to close the displayed Site. 
Print… Prints a report. 
Print Preview  Displays the report on the screen before you print it. 
Print Setup… Enables you to determine the Print specifications. 
Users  Enables you to manage users. 
Exit  Exits Amber Basic PC Remote Programmer. 

3.2 Edit Menu 
The Edit menu contains commands that help you edit and fill in details in each screen. 

Menu Item Function 

Cut Removes selected text to the clipboard. 

Copy Copies selected text to the clipboard. 

Paste Places the text being held in the clipboard at the point of insertion. 

3.3 View Menu 
The View menu contains items that enable you to control the appearance of your Amber Basic PC 
Remote Programmer screen. 

Menu Item Function 

Toolbar Displays or hides the Tool bar 
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Menu Item Function 

Status Bar Displays or hides the Status bar. 

Next Table Displays the next table of the List of Tables. 

Previous Table Displays the previous table of the List of Tables. 

Messages 
Window 

Displays the incoming and outgoing messages. 

Options… Displays the Options window. 

3.4 Communications Menu 
The Communications menu enables you to manage the Communication process with the 
control panel. All of these functions appear on the toolbar.  

Menu Item Function 

Login Begins the login/logout process to/from the control panel. 

Update Login 
Data… 

Enables updating the download and installer code when system is armed. 

Download Downloads data from the Amber Basic PC Remote Programmer to the 
control panel. 

Upload Uploads data from the control panel to the Amber Basic PC Remote 
Programmer. 

Download Table Downloads the currently displayed table from the Amber Basic PC 
Remote Programmer to the control panel. 

Upload Table Uploads the currently displayed table from the control panel to the Amber 
Basic PC Remote Programmer. 

Change system 
Time & Date… 

Sets the time and the date that will be downloaded to the control panel. 
This option is only enabled when the communication between the Amber 
Basic PC Remote Programmer and the control panel is enabled. 

Update Time & 
Date On Logout 

Automatically updates the control panel date and time when disconnecting 
from the control panel. 

Port Auto 
Detection… 

Automatically begins a search for the control panel that is connected by 
Serial Communication mode. 

Settings Enables you to specify communication settings by selecting options in the 
Communications tab of the Options dialog box. 
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3.5 Advanced Menu 
The Utilities menu enables you to perform changes to the panel settings. 

Menu Item Function 

Settings  Enables you to specify display settings by selecting options in the Display 
tab of the Options dialog box. 

3.6 Help Menu 
The Help menu enables you to receive information and guidance in managing Amber Basic 
PC Remote Programmer. 

Menu Item Function 

About Amber 
Basic Remote 
Programmer… 

Provides Amber Basic PC Remote Programmer copyright and version 
information. Click on the Home Health Care logo to display our Home Page, 
which contains important information about using Amber Basic PC Remote 
Programmer. 
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Chapter 4: Sites 
4.1 Introduction to Sites 

Amber Basic PC Remote Programmer enables you to manage Sites in a variety of ways. 
These features are accessible either from the menus or from the Site List window. 

The Site List window is displayed either when the program is first initiated, or 
by clicking the Sites button in the tool bar or by selecting List of Sites in the 
Sites menu.  

 
Figure  4-1: Site List Window 

This window displays a list of the site names whose files are located in the directory displayed 
in the Sites Location field. The first time the program is initiated, the path displayed will be 
the path where the Amber Basic PC Remote Programmer is installed on your computer. In 
later sessions, the Sites Location field will display the path last chosen (either typed in or 
selected using the Browse button). Using the Browse button, it is possible to locate and access 
a site file anywhere in the network and not just access site files saved to your local computer. 

Each column of the site list table can be sorted in either descending or ascending order by 
clicking on the column title. You can drag the vertical lines that separate the columns to 
enlarge or reduce the size of the columns. 
The screen displays buttons, which enable you to begin working with Amber Basic PC 
Remote Programmer: 

Button Function 
Open Opens an existing Site 
New Opens a new Site 
Copy  You can create a new site based on an existing similar site 
Delete Deletes a Site 
Cancel Closes the Site List Window. 
Browse Opens the Browse for Folder dialog box, which enables you to 

locate a folder where the Site files are located. 
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Button Function 
Search Lists all the file names containing the text entered into the 

Search window. If "Look in sub directories" is not checked, the 
search will be performed only on Sites location (the root 
directory). 

4.2 Creating a New Site 
You can create a new, empty site file or you can copy an existing file, save it under a new 
name, and make the relevant changes to tailor it to a similar setup as the original. You can 
create a new site either via the Site List window or directly in the New Site window. 

Click New in the Site List window, 

or 

In the Sites menu, click New Site.… 

The New Site dialog box appears.  

 

Figure  4-2: New Site Window - Work Offline 

The New Site dialog box has two tabs:  

Work Offline: Enables defining and changing parameters offline and at a later time 
downloading these parameters to the control panel. 

Work Online: Enables direct operation with the control panel via a serial port or telephone 
modem.  

By default the New Site dialog box opens with the Work Offline tab open to enable you to 
create the configuration file before the installation.  
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Working Offline 
Work Offline only if you know the Amber Basic model you want to connect to. 

1. Select the Work Offline tab. The following screen will be displayed: 

 

Figure  4-3: New Site Window - Work Offline 

2. Select the Amber Basic model. 

3. Click OK. 

The Amber Basic PC Remote Programmer main screen will display the parameters relevant 
for the selected model. 

Working Online 

To work via a telephone modem 

1. In the New Site window click Options…. The Options Communications window 
appears. 
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Figure  4-4: Options - Telephone Modem Communications Mode 

2. Select Telephone modem in the Communications mode field. 

3. Ensure that the correct modem is selected and configured.   

4. Click OK. 

 The New Site window will appear displaying the Work Online tab with the 
Phone Number field and the Auto detection checkbox disabled. 

 

Figure  4-5: New Site Window - Telephone Modem Mode 
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5. Enter the phone number. 

6. Enter the download code located in the control panel. The Login button and the 
Auto Detection checkbox will become enabled.  

7. Check the Auto Detection checkbox if you want the program to automatically 
scan the computer ports to detect the presence of an Amber Basic PC Remote 
Programmer port.  

8. Click Login. The Modem Dial Up... window will appear and attempt 
connecting. 

 
Figure  4-6: Modem Dial Up 

 If you marked the Auto Detection checkbox, the program will start scanning the 
different ports to look for an Amber Basic PC Remote Programmer and will then 
connect to the Amber Basic PC Remote Programmer and verify the download 
code. 

 If you did not mark the auto detection checkbox, the program will try to 
connect to the Amber Basic PC Remote Programmer via the serial port 
defined in the Communications settings. 

9. Click Connect. The Hang Up button becomes enabled. 
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Figure  4-7: Modem Hang Up 

10. Wait for two or three rings, and then click the Hang Up button. 

 
Figure  4-8: Communicating with PC  

The system will wait for 12 seconds and then will automatically dial again. The Amber 
Basic will answer the call after the first ring and will initiate a data session with your 
PC. 

To work via a serial port 

1. In the New Site window click Options…. The Options Communications window 
appears. 
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Figure  4-9: Options - Serial Port Communications Mode 

2. Ensure that Serial port is selected in the Communication mode field and that 
the serial port details are correct (refer to chapter 7: Connecting to the Amber 
Basic Control Panel for further details). 

3. Click OK. 

 The New Site window will appear displaying the Work Online tab with the 
Phone Number field disabled. 

 
Figure  4-10: New Site Window - Work Online via a Serial Port 

4. Click Login. 
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4.3 Saving a Site  
From the Sites menu, select Save, or click the Save button on the toolbar; Amber Basic PC 
Remote Programmer automatically saves the site file on which you are working. 

When you select Save or click the Save button for the first time after creating a new site 
file, Amber Basic PC Remote Programmer displays the Save As screen. 

 
Figure  4-11: Save As... Screen 

• Save – This is the directory in your computer that your Site will be saved in.   

• File name – The name that the Site you are trying to save will be called.  

• Save as type – This is the type of file that your Site will be saved as.   

Do not change this, make sure that it is always left as AmberBasic Files (*.pmx) 

• Save – The save button is what you press when you are done with the Save As box.  This 
will complete the saving process. 

It is recommended that you save every Site with the account number it was assigned.  This 
will make it easy to locate and open saved Sites if they are needed in the future. 

Note: In the case where programming is performed by multiple workstations, it is 
recommended to save all *.pmx files in a shared network directory. 

4.4 Saving a Site File with a New Name 
This enables you to save the site file with a new name and in a different directory. 

1. From the Sites menu, select Save As; Amber Basic PC Remote 
Programmer displays the Save As screen.  

2. Enter a suitable name for the new site and locate the directory where you 
want to save the file. 
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4.5 Displaying and Editing Existing Site Files 
Once you have created a site, and saved it, you can view it at any time.  

1. Either select the site from the recently used files in the Sites menu or 
select the site name to display in the Sites List window, and click Open.  

2. The Amber Basic PC Remote Programmer main window displays the 
information of the selected site. 

3. Edit the site tables as necessary. 

4.6 Copying a Site 
You can create a new site based on an existing similar site. This is done by copying an 
existing site file, saving it with a new name and then making and saving the necessary 
changes. 

1. In the Site List window, select an existing site file. 

2. Click Copy; an edit box appears prompting you for the name of the new 
site.  

3. Type the new site name, then click OK. 

 The Amber Basic PC Remote Programmer main window appears and 
displays the details of the copied site. 

4. Edit the site as necessary. 

5. Click Save to save the site. 

4.7 Deleting a Site 
When a Site is no longer active, and it is no longer necessary to store it in Amber Basic PC 
Remote Programmer, you can delete it. 

1. In the Sites List, select the site to delete, then click Delete, a warning box 
appears reminding you that any account that you delete is not retrievable. 

2. Click Yes to delete the account, or No to return to the Sites List. 

 If you click Yes, the selected site is deleted and the Sites List is displayed. 
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4.8 Exiting the Site List Window 
When you open Amber Basic PC Remote Programmer, the Sites List displays an Exit 
button. However, when you display the Sites List from within the application, the Exit 
button is replaced by a Cancel button. 

Click Exit to exit Amber Basic PC Remote Programmer. 

Click Cancel; the Sites List closes, and the main Amber Basic PC Remote Programmer 
screen becomes active. 
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Chapter 5: Users 
From the Sites menu, select Users; Amber Basic RP Remote Programmer displays a menu 
that enables you to manage the Amber Basic RP Remote Programmer users. 

Menu Item Enables you to: 

Add new user Add a new user name and password. 

Delete user Delete a user. 

Login as different 
user 

Login as a different user without exiting Amber Basic RP Remote 
Programmer. 

5.1 Adding New Users 
1. From the Sites menu, select Users, then Add new user…; the Add new 

user dialog box will appear. 

 
Figure  5-1: Add New User Dialog Box 

2. In the User Name edit box, type the user's name. 

3. In the Password edit box, type the user's password. 

4. In the Confirm Password edit box, retype the user's password. 

5. Click the Access Level drop-down arrow and select from the list your access 
level. 

6. Click Add; a message box appears confirming the addition of the user to the 
system. 

5.2 Deleting a User 
1. From the Sites menu, select Users, then Delete user…; the Delete user dialog 

box will appear. 
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Figure  5-2: Deleting User Name Dialog Box 

2. In the User Name edit box, type the user's name.  

3. In the Password edit box, type the user's password. 

4. Click Delete; a message box appears confirming the deletion of the user from 
the system. 

5.3 Login as a Different User 
1. From the Sites menu, select Users, then Login as a different user…; the Amber 

Basic RP Remote Programmer Login screen appears. 

 
Figure  5-3: Login Screen 

2. In the User Name edit box type the user's name and in the Password edit box 
type the user's password. 

3. Click OK; a message will appear to notify that the password has been changed 
successfully. 
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Chapter 6: Data Table Details 
The data tables’ details display the parameters that can be uploaded from or downloaded to 
the Amber Basic control panel. When first creating a site file, the values displayed are 
default values, which can be altered to suit the specific system.  

Use the arrow keys to navigate between the cells and focus on the different parameters, 
then click the left mouse button or press ENTER to edit the cell and change the values.  

Amber Basic PC Remote Programmer includes the following tables:  
• Site Information 
• User Settings 
• Transmitters 
• Panel Definitions 
• Communications Definitions 
• Pendant Test 
• Reminders 
• Event Log 

6.1 Site Information 
This section provides various types of information on Amber Basic PC Remote 
Programmer sites, including site connection and location details. 

Panel Site Name – The name of the site in which the control panel is installed. 

System Manager – The name of the System Manager responsible for programming the 
control panel, and responding to alarm and to other events. 

Address, City, State, and Zip Code – The complete address of the site. 

Primary Phone No. – The telephone number which the Amber Basic PC Remote 
Programmer modem uses to connect to the control panel in the control station. 

Primary Communication Mode – The mode of communication such as PSTN direct 
(POTS line) used to establish connection between the Amber Basic PC Remote 
Programmer and the control panel.   

Additional Information - Additional important information about the Amber Basic PC 
Remote Programmer site and facilities. 

Download Code – A 4-digit password used to enable downloading data into the control 
panel. 

User Code (Remote Access Code) – A 4-digit password used to manage the control panel 
through the remote connection from a private telephone. 
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6.2 User Settings 
User Settings enables you to define Amber Basic PC Remote Programmer settings, 
applicable to each individual site. 

Last Upload System Time - The Amber Basic PC Remote Programmer system time when 
the last upload was received from the on-site control panel. The software application will 
update this field automatically. 

Last Upload System Date - The Amber Basic PC Remote Programmer system date when 
the last upload was received from the on-site control panel. The software application will 
update this field automatically. 

Panel Time-Date - The software will update this field automatically. 

Time Format - You can adjust the control panel built-in clock to show the time in 
European format (hh:mm) or US format (hh:mm AM/PM). 

Date Format - You can adjust the control panel built-in calendar date to show the date in 
European format (dd/mm/yyyy) or US format (mm-dd-yyyy). 

6.3 Transmitters  
This feature enables you to enroll RF devices. 

Zone #: Lists zones in numerical order. 

Type – Click the drop-down arrow and select from the list the relevant device type. 
Options: Non-alarm, Emergency, Flood, Gas, 24 Hours, Fire, Fall Detector, Pills Dispenser. 

Enrolled – Notifies whether or not the device is enrolled. 

RF ID # – Transmission ID number. 

Name – Displays the name of the device. 

6.4 Panel Definitions 
Panel Definition enables you to customize the control panel to suit each individual user. 

Supervision Interval – Determines the time interval for reception of supervision reports 
from supervised wireless devices. If any device does not report at least once within the 
selected time limit, an "INACTIVITY" alert will be initiated. Options: 1 Hour, 2 Hours, 
4 Hours, 8 Hours, 12 Hours or Disable. 
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No Activity Time - Determines the time limit for reception of signals from sensors used to 
monitor the activity of the sick, elderly, or handicapped. If no device detects and reports 
movement at least once within the defined time limit, a 'not-active' alert will be initiated. 
Options: 3 Hours, 6 Hours, 12 Hours, 24 Hours, 48 Hours, 72 Hours or Disable. 

6.5 Communications Definitions  
Communications Definitions enables you to set the telephone communication parameters to 
the requirements of the particular Site.  

Autotest Time – The time interval between consecutive tests of the telephone line. Options: 1 
day, 5 days, 7 days, 30 days or Disabled. 

Autotest cycle –The time interval between consecutive telephone line test messages sent to 
the central station. The control panel performs this at regular intervals to verify proper 
communications. Options: 1 Day, 5 Days, 7 Days, 30 Days or Disabled. 

Area Code – The system tel. area code (up to 4 digits). 

Out Access Number – The number that is used as a prefix to access an outside telephone line 
(if exists). 

Central Station Emergency Tel. No. – The telephone number of the central station (including 
area code, 16 digit max) to which the Amber Basic PC Remote Programmer will report 
events. 

Emergency Report Account No. – The number that will identify your specific alarm 
control system to the central station. The number consists of 6 hexadecimal digits 

Central Station Maintenance/Alarm Tel. No. – The telephone number of the central station 
(including area code, 16 digit max) to which the Amber Basic PC Remote Programmer will 
report alarm and non-alarm events. 

Report Format – The format by which the control panel will report events to central 
stations. Options: Contact ID, SIA, 4X2 1900/1400, 4X2 1800/2300 or Scancom. 

 4/2 Pulse Rate – The pulse rate at which Amber Basic PC Remote Programmer will send 
data to central stations, if any of the 4x2 formats has been selected. Options: 10 pps, 20 pps, 
33 pps or 40 pps. 

Send 2wv Code – Here you determine whether the Amber Basic PC Remote Programmer 
will send two-way voice code to the central station (to switch the central station from data 
communication to voice communication state) by using pre-selected SIA or Contact-ID 
communication formats only. Options: Send or Don't Send. 

Voice Session - Central Stations – Opens a two-way voice session with the central station. 
Options: Enable or Disable. 
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Ringback Time – Here you determine the period during which the central station can 
establish 2-way voice communication with the Amber Basic PC Remote Programmer (after 
1 ring), if an alarm type message was received by central station or the Ringback function 
was selected. Options: 1 minute, 3 minutes, 5 minutes or 10 minutes. 

Central Station Dialing Attempts – You can either enable or disable the voice prompts and 
messages sent to the central station. 

1st Private Tel. No. – You type the number of the first private telephone to which the 
system will report events. 

2nd Private Tel. No. – You type the number of the second private telephone to which the 
system will report events. 

3rd Private Tel. No. – You type the number of the third private telephone to which the 
system will report events. 

4th Private Tel No. – You type the number of the fourth private telephone to which the 
system will report events. 

Voice Session - Private Phones – You can either enable or disable the voice prompts and 
messages sent to private phones. Options: Enable or Disable. 

Private Telephone Dialing Attempts – The number of attempts that Amber Basic PC 
Remote Programmer will make to establish communication with private telephone 
subscribers. Options: 1 attempt, 2 attempts, 3 attempts or 4 attempts. 

Reporting to Private Telephones – The events that Amber Basic PC Remote Programmer 
will report to private telephone numbers. Alerts and Disable Report. 

Private Telephone Acknowledge – The private telephone report acknowledge mode. There 
are two modes:  
Single Acknowledge - When the Control Panel receives an acknowledge signal from one 
private telephone subscriber, it considers the current event closed. The remaining 
acknowledge signals are for backup purposes only.  
All Acknowledge - The Control Panel must receive an acknowledge signal from all private 
telephone subscribers in order to consider the current event closed. 

Remote Access – Determines permission to access and modify the Control Panel from a 
remote telephone. Options: On and Off. 

Dialing Method – The dialing method used by the Amber Basic PC Remote Programmer 
automatic dialer. Options: Tone (DTMF) and Pulse. 

Line Failure Report – Here you determine if the telephone line disconnection will be 
reported or not and determine the delay between detection of line disconnection and the 
failure reporting. If the telephone line is disconnected, the message "tel line fail" will be 
stored in the event log. Options: Don't Report, Immediately, 5 Minutes, 30 Minutes, 60 
Minutes or 180 Minutes. 
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Ambient Level – In this section you select the ambient noise level of the installation. If it is 
relatively noisy environment, set it to High Level (default setting). If it is very quiet 
environment, set to Low Level. 

6.6 Pendant Test  
The pendant test Scheduler enables you to perform regular test procedures of enrolled 
pendants. The Scheduler enables you to determine start and stop test settings for the 
applicable pendants. You can select the day (Sunday, Monday, Tuesday, Wednesday, 
Thursday, Friday, Saturday, or daily) and then select the scheduled start/stop times for the 
test to be performed on the applicable pendant. 

 
Figure  6-1: Pendant Test Scheduler 

6.7 Reminders 
This feature enables you to set programmable reminders per day. The reminder is 
announced by a voice message and also appears on the Amber Basic LCD display. 
Reminder Schedule – Enables you to set a recurring reminder: daily; weekly; monthly; or 
yearly. 
Reminder Type - Select one of the following reminder options: 

• Wake Up 

• Wellness  

• Health test 

• Medication 

Caution: When setting reminders for more than one reminder type, the reminder Start 
time of each subsequent reminder type must be set to a minimum of 10 minutes after the 
previous reminder Stop time. For example, if the Stop time for the Medication reminder is 
set to 10:20, the Start time for the Wake Up reminder must be set to not before 10:30. 
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Figure  6-2: Reminders Scheduler 

6.8 Event Log 
The Amber Basic maintains a log file of the last 250 events. The event log can be uploaded to 
the Amber Basic PC Remote Programmer. 
Event # – Lists events in numerical order. 
Zone/User # – Displays the wireless device number or zero “0” for a system event with the 
user number. 
Event Type – Type of event. 

Date and Time – Displays the date and time of the event. 

To upload the event log table 

1. Perform login. 

2. Select the Event Log table. 

3. Click the Upload Table icon on the toolbar 

The Amber Basic PC Remote Programmer uploads all events in the table. A log file can 
contain up to 250 events in FIFO format (first-in, first-out), whereby new events overwrite 
the oldest events.   
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Chapter 7: Connecting to the Amber 
Basic Control Panel 

Connecting to the Amber Basic control panel enables the Amber Basic PC Remote 
Programmer to transfer information to and from the control panel. The control panel can be 
connected by remote connection (via telephone modem), used when the operator specifies 
the parameters off-site, or by local connection (via RS-232), used when the installer uses a 
PC to specify the parameters on-site.  

Once connected, it is possible to perform a number of operations, such as, uploading site 
parameters, downloading site parameters or changing system date and time.  

7.1 Defining Communication Settings 
The Communications dialog box enables you to determine the communication settings 
through which the Amber Basic PC Remote Programmer and the control panel 
communicate. 

From the View menu, select Options, and then click on the Communications tab; the 
Communications dialog box appears. 

 
Figure  7-1: Options - Communications Tab 
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7.2 Local Connection (Serial Port)  
Local connection is used when the Amber Basic PC Remote Programmer is within direct 
cable connection distance from the Amber Basic control panel. When using the Local 
Connection option there is no need for a modem. Only communication ports without installed 
modem drivers may be used in Serial mode. For example, if the modem drivers are installed 
on the ports COM2 and COM3, then only ports COM1 and COM4 may be used for 
connection in Serial mode. 

1. From the Communications mode drop-down list, select Serial Port. The serial 
port parameters are displayed as follows: 
• The Comm port field becomes enabled. 
• The Baud rate field displays 9600, this being the baud rate used for serial 

connection. The Baud rate field is disabled. 
• The Parity and the Stop bits fields do not change and are disabled. 

 
Figure  7-2: Communications Mode - Serial Port 

2. Change the Comm port field as necessary. 

3. Auto-Detection Option: Check the Auto detect AmberBasic when program 
starts checkbox, so that when starting the program, the system will 
automatically search for the control panel connected to the communication port. 

 Note: The auto-detection option can also be activated by selecting Port 
Auto Detection from the Communications menu or by checking the 
relevant checkbox in the New Site dialog box. 

4. Click OK. 
 Note: When the auto detection procedure is initiated, either when starting 

the program or when choosing this option in the Communication menu or 
New Site dialog box, the following screen will appear, showing you the 
names of the ports being scanned. 
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Figure 7-3: Progress Bar  

7.3 Remote Connection (Telephone Modem)  
This is applicable when using a dial-up (PSTN direct) connection to the Amber Basic. 

1. From the Communications mode drop-down list, select Telephone Modem. 
The telephone modem section becomes enabled, and the serial port parameters 
change automatically to be displayed as follows: 
• The Comm port field becomes disabled and the field value is the 

communications port where the modem is connected. 
• The Baud rate field displays 300, the baud rate used for telephone modem 

connection. 
• The Parity and the Stop bits fields do not change and are disabled. 

  
Figure  7-4: Communications Mode – Telephone Modem 
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2. In the Modem section of the dialog box, select from the Modem drop-down list, 
the modem to use for connecting to the control panel. 

3. Click Settings to display the Modem Settings dialog box, and define the dialing 
and modem parameters. 

 
Figure  7-5: Modem Settings 

4. To connect to the Amber Basic modem, the local software performs a Ring-Hang 
up-Ring procedure: 

 Step 1: Ring – dials, waiting for 2-4 rings (in the Dialer field of the 
Modem Settings dialog box enter value in Wait for 2-4 Rings During, see 
Figure  7-5 above) and then disconnects the line. 

 Step 2: Hang up – waits for a period of time (in the Dialer field of the Modem 
Settings dialog box enter value in Dialing for Connection, see Figure  7-5 
above). 

 Step 3: Ring – dials to the unit for the second time. If the Ring-Hang up-Ring 
procedure succeeds, then the modem session starts. 

 The Try to connect field defines the number of times the Ring-Hang up-Ring 
procedure should be initiated. The Wait for 2-4 rings during field defines the 
Ring steps duration as follows:  
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1. In the 1st step duration the ring time differs depending on the phone 
service provider used, meaning that the overall time may be affected by 
the physical distance. 

2. In the 2nd step duration, modems take different periods of time to 
synchronize and be connected. 

 The Dialing for Connection field defines the second step time-out which must 
be set between a 7-30 seconds time interval. 

7.4 Connecting to Amber Basic 
The login procedure enables Amber Basic PC Remote Programmer to transfer information to 
and from the control panel and can be initiated either when creating a new site file or when a 
site file is already open. This procedure differs when the communications mode is set to 
Serial Port or Telephone Modem: during a local communication, the Ring-Hang up-Ring 
procedure described above does not occur.  

7.5 Online Operations 
While connected to the Amber Basic, it is possible to perform a number of different 
operations. You can transfer information between the Amber Basic PC Remote 
Programmer and the control panel by uploading or downloading either all site parameters 
or a specific table. It is also possible to update the system date and time. 

To Download or Upload from All Site Parameters 

From the Communications menu, select Download or Upload,  

Or 

Click the appropriate icon on the toolbar.  

The system begins to transfer data between the control panel and the Amber Basic PC Remote 
Programmer. The wording on the message box changes according to whether the transfer is 
Download or Upload. 

 
Figure  7-6: Uploading/Downloading Progress Bar Screen 
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At any point during the transfer, you can click Cancel to halt the procedure. 

When the transfer is complete, a message box appears to confirm successful completion. 

To Download or Upload a Specific Table 

1. Select a table by clicking on a table name in the List of Tables area, or by 
clicking a table tab at the bottom of the screen. 

2. From the Communications menu, select Download or Upload, or click the 
appropriate icon on the toolbar.  

7.6 Disconnecting from the Amber Basic 
From the Communications menu, select Logout,  

Or 

Click the Logout icon on the toolbar.



Data ______________________________________________________________________8-1 

Chapter 8: Data 
The data tab is used to define specific upload/download settings to facilitate data transfer.  

8.1 Defining Data Settings 
The Data dialog box enables you to customize specific data settings in the 
upload/download process. 

From the View menu, select Options, and then click on the Data tab; the Data dialog box 
appears. 

 
Figure  8-1: Options – Data Tab 

1. Check the Send updated data immediately checkbox, to automatically update 
changed settings from the Amber Basic PC Remote Programmer to the Amber 
Basic. 

 Note: If the above field is not checked, the Amber Basic will only be updated 
when performing full download. 

2. In the Delay after acknowledge during download box, enter a time value (in 
milliseconds) for a delay in sending commands.  

Note: Delay after acknowledge during download should be used only when problems 
in communication are experienced. 
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3. Check the Enable customizing Full Upload/Download Data field, to enable 
uploading/downloading of customized settings.  

Mark the relevant check boxes to specify the data to be uploaded to the Amber 
Basic control panel. 

Attention: Use the same customized fields for both uploading and downloading in 
order to prevent inconsistency in the data. 

Note: Click the Next/Prev buttons to see all the available fields. 

4. Click Apply; the Amber Basic PC Remote Programmer submits to memory the 
updated data. The Options dialog box remains on the screen for further perusal 
and selection 

5. Click OK; Amber Basic PC Remote Programmer updates the system according 
to your specifications. 
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Chapter 9: Reports 
After you have created a site, you can generate a printable report of the site data. To 
generate a report, first define the information to include in the report, preview the report 
and then print it. 

9.1 Defining and Generating a Report 
Each Amber Basic PC Remote Programmer account comprises of 7 tables. You can 
generate a report including information about some or all of these details. After you specify 
which details you require in the report, Amber Basic PC Remote Programmer will generate 
the report. 

To Define and Generate a Report 

1. From the View menu, select Options, or  

 Click the Options button on the toolbar; the Options dialog box appears. 

2. Click the Reports tab; the Reports dialog box appears. 
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Figure  9-1: Options – Reports 

Mark the relevant check boxes to specify the information to include in the Report. 

3. Click Apply; the tables to include in the report are selected, and the Reports 
dialog box remains on the screen for further perusal and selection. 

4. Click OK; Amber Basic PC Remote Programmer generates the report according 
to your specifications. 

9.2 Viewing a Report 
Amber Basic PC Remote Programmer enables you to view reports before you print them. 
This enables you to check that you have included all the necessary information in the 
report. 

To View a Report  

From the Sites menu, select Print Preview. 

Amber Basic PC Remote Programmer displays the report of the site on the screen as you 
have specified for printing in the Options dialog box. This enables you to view the different 
details of the report before you print it. 
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The Print Preview toolbar enables you to do the following: 
Print Prints the report from the Print Preview screen. 
Next Page Displays the following page of the report. 
Prev Page Displays the previous page of the report. 
First Page Displays the first page of the report on the screen. 
Last Page Displays the last page of the report on the screen. 
Whole Page Displays one page of the report on the screen. 
Page Width Fits the page to the width of the window. 
Two Pages Displays two pages of the report on the screen. 
Thumbnail Opens a navigation pane of thumbnails of each report. 
Zoom  Increases the size of the report as it appears on the screen. There 

are five possible view sizes available. 

9.3 Printing a Report 
You can change the print setup for a report. This enables you to determine the following: 
• The printer to print the report. 

• The paper size on which to print. 

• The source from which the printer should take paper. 

• The orientation of the paper. 

To Determine the Print Setup 

1. From the Sites menu, select Print Setup; the Print Setup dialog box appears. 

2. Specify the printer to where the report will be printed. 

3. Specify the paper size of the paper on which the report will be printed. 

4. Specify the paper source. 

5. Specify the orientation of the paper. 

6. Click OK. The window is closed. 

To Print a Report 

1. From the Sites menu, select Print (or click the Print button on the toolbar); 
Amber Basic PC Remote Programmer displays the Print screen.  
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Figure  9-2: Print Dialog Box 

This screen enables you to do the following: 

• Select the printer to print the report. 

• Determine the print range. 

• Determine the number of copies of the report, and whether or not they should be 
collated. 

2. Make the appropriate changes, and then click OK; Amber Basic PC Remote 
Programmer prints the report.
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Chapter 10: Screen Appearance 
Any changes to the appearance of the Site screens are made in the Display tab of the 
Options dialog box. 

 
Figure  10-1: Options - Display Tab 

10.1 Changing the Color 
The colors of the Table Details are defined according to the following settings: 

• Table zebra color: Defines the color of every other line in each table. This makes it 
easier for the user to follow the horizontal lines in the table.  

• Table disabled option color: Disabled tables appear in the selected shade. 

• Table normal option color: The color of the text as you type it. 

• Background color: The background color of the tables list and the sites list. 
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To Change the Tables Color 

1. From the View menu, select Options; the Options dialog box appears. By 
default, the Display tab is active. 

2. Click on the block of Tables zebra color; the color palette appears. 

3. Select a color, then click OK. 

4. Repeat the procedure for all the options. 

5. Restart Amber Basic PC Remote Programmer. 

10.2 Column Alignment 
Amber Basic PC Remote Programmer defines the Table Details column alignment 
according to one of the following settings: The Tables Column Alignment determines the 
width of the table columns on the screen. 

• No auto alignment: All columns in the tables are the same width, regardless of their 
contents. 

• Right justified: The columns in the table are all widened in order to cover the entire 
screen. 

• Last column stretched: The last column in the table reaches the right side of the screen, 
however wide the contents of the column. 

• Additional column: An additional column is added to the tables that are too narrow to 
fill the screen. The extra column is the width of the empty space between the last 
column of the table, and the right side of the screen. 

To Change the Tables Column Alignment 

Click the column alignment drop-down arrow, then select an option from the list. 

10.3 User Interface Language 
Amber Basic PC Remote Programmer provides you with the possibility to change the 
language used in the software interface.  

To Change the User Interface Language 

1. Click the Language User Interface language drop-down arrow, then select a 
language from the list.  

2. Restart Amber Basic PC Remote Programmer. 
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10.4 File Naming  
File naming provides you with the option to include the account number in the file name.  

To Include the Account Number in the File Name 

1. In the File Naming section; check the File name must include the Account 
Number check box.  

2. Click OK.
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11. Troubleshooting 
PROBLEM DIAGNOSIS POSSIBLE SOLUTION 

A1. Your modem 
might be OFF or 
loosely 
connected.  

A1. Make sure the modem is turned ON. A 
power switch is available on any external 
modem. The light on the front panel should 
illuminate.  
Also ensure that all other applications using 
the COM Port are turned off (PalmPilot 
Hotsyc and other accessories or terminal 
windows). 
Check whether the cable connectors are 
fitted securely to their respective ports: 
• The line connector in case of an internal 

modem  
• The line and RS-232 connectors in case 

of an external modem.  

A.  The Amber Basic 
PC Remote 
Programmer 
doesn't identify the 
modem 
 

A2. You may have a 
COM\IRQ 
conflict. 

A2. Check whether you have the correct Com 
port and IRQ settings in your software 
and/or in the Windows Control Panel. Also 
verify that there are no conflicts with other 
devices. 

(See section 2.2 for further details) 
B1. You may have a 

conflict with the 
definitions in the 
communication 
mode window. 

B1. Make sure you selected the Telephone 
Modem option in the communication mode 
window.  

B2. The modem type 
is different from 
the type displayed 
in the OPTIONS 
menu / Com-
munications tab. 

B2. Check that the correct modem type has been 
selected. 

 

B.  Failure to com-
municate with the 
Amber Basic via 
the modem.  

B3. Modem is not 
properly installed 
in operating 
system 
(Windows). 

B3. Make sure that the modem is recognized by 
Windows.  

  If not, click Start → Setting → Control 
Panel. Double click the Modems icon and 
follow the instructions on the displayed 
Install New Modem window. 
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PROBLEM DIAGNOSIS POSSIBLE SOLUTION 
 B4. Amber Basic is 

not connected to 
the phone line. 

B4. Verify proper connection of the Amber Basic 
to the phone line. 

(See section 7.3 for further details) 
C1. The RS-232 cable 

is disconnected 
from the Com 
Port of your PC. 

C1. Verify proper connection of the RS-232 
cable.  

C2. You may have a 
definition conflict 
in the OPTIONS 
menu/ Commun-
ications settings 

C2. Make sure that the Serial Port option is 
currently selected. 

 

C3. Your serial port is 
defined to work 
with a higher or 
lower baud rate. 

C3. Make sure that the modem speed is set to 
9600 bps in the OPTIONS menu / 
Communications.  

C.  PC fails to 
communicate with 
the Amber Basic 
via the Serial Port. 

C4. You may have a 
COM Conflict. 

C4. Verify that the correct Comm Port is 
specified in the OPTIONS menu / 
Communications 

(See section 7.2 for further details) 
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Appendix A: Language Settings 
When using the Amber Basic PC Remote Programmer Software in Windows 2000/XP with 
a foreign language interface, some characters may not appear correctly in the chosen 
language. This may require changing the language settings. 

Changing Language Settings in Windows 2000 

1. From Start>Settings>Control Panel double-click Regional Options. The 
Regional Options dialog box appears. 

 
Figure A-1: Regional Options Window 

2. Click Set Default; the Select System Locale dialog box appears. 

 
Figure A-2: Select System Locale Window 

3. Click the drop-down list and select the appropriate language. 
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4. Click OK. 

5. Restart the computer. 

Changing Language Settings in Windows XP 

1. From Start>Settings>Control Panel double-click Regional and Language 
Options. The Regional and Language Options dialog box appears. 

 
Figure A-3: Regional and Language Options Window 

2. Click on the Advanced tab. 

3. Under Language for non-Unicode programs, click the drop-down list and 
select the appropriate language. 

4. Click OK. 

5. Restart the computer. 
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